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Povzetek

Pogosto v google vtipkam kakšno floskulo, pa se moja hudomušna rado-
vednost kaj hitro zresni, saj rezultati iskanja dobesedno prerešetajo center 
predvidene tarče. Glasbeniki, še posebej instrumentalisti, smo pregovorno 
konservativni, saj se že iz rane mladosti ukvarjamo s temeljnimi znanji in 
veščinami znova in znova, vsak dan od vsega začetka. Na splošno lahko torej 
zatrdimo, da vseživljenjsko učenje ni za nas nič novega. Pa vendar se mnogi 
pedagogi še vedno zdrznejo pred nenehnimi izzivi, bodisi ko ravnatelji od 
njih terjajo digitalno pismenost, bodisi ko jih učenci »off the record« seveda 
pobarajo, kako bi v nekem računalniškem programu postorili to ali ono. 
Zaradi interdisciplinarnosti se tako učenje računalniških znanj ne more 
več omejevati zgolj na predmet računalništva. Informatika v najširšem 
pomenu postaja vedno bolj vključena v ves šolski predmetnik, predvsem 
zaradi vsesplošne vpetosti v vsakdanje življenje in delo učiteljev, kakor 
tudi izobraževanje učencev. Izgrajevanje digitalne pismenosti se pričenja 
v osnovnošolskem obdobju vse bolj zgodaj. Vse breme učnega procesa še 
vedno sloni na temeljnih učnih zmožnostih posameznega učitelja. 
Tako ne presenečajo različne agende, resolucije in reforme v izobraževal-
ni sferi. V ospredje prihaja praktično znanje in učenje kritične uporabe 
digitalnih orodij s poudarkom na varni rabi in občutljivi zasebnosti. Gre 
za stalen in neustavljiv proces, ki pa ga bodo učitelji lahko podprli le, če 
bodo ustrezno opremljeni z digitalnimi zmožnostmi.2 

Ključne besede: IKT, digitalna pismenost, digitalne zmožnosti, e-
glasba, glasbena informatika, Sibelius, učni listi, i-tabla

Abstract

Musicians, especially instrumentalists, are known for their prover-
bial conservative views resulting from working on basic knowledge 
and skills repetitively, every day, from an early age onwards. Gener-
ally speaking, we could say that life-long learning does not represent 
a new concept to us. And yet many pedagogues still flinch when faced 
with constant challenges: whether it is headmasters requiring digital 
literacy of them, or students asking them “off the record” how to do 
this or that in a computer programme.
Teaching computer skills can therefore no longer be confined to the 
subject of computing. Information technology is becoming increas-
ingly involved in all school subjects, mainly due to its widespread 
integration into everyday life and work of teachers, as well as educa-
tion of students. Building digital literacy begins in the primary school 
period and the entire burden of the learning process still lies with each 
teacher and his or her academic abilities. 
Various agendas, resolutions and reforms in the field of education 
therefore come as no surprise. Practical knowledge and learning how 
to use digital tools sensibly, with an emphasis on safety and privacy, 
are thus making their way into the forefront. This is a continuous and 
unrelenting process, which teachers can become a part of only if they 
are adequately equipped with computer skills.

Key words: ICT, digital literacy, digital skills, e-music, information 
technology in music, Sibelius, worksheets, interactive whiteboard.

1 Program Sibelius je zaradi hitrosti, enostavnosti in prijaznosti do uporabnika 
izjemno priljubljen med glasbenimi pedagogi, učenci, skladatelji, aranžerji, 
notatorji in ostalimi glasbeniki, več na www.sibelius.com

2 ipts.jrc.ec.europa.eu, European Commission, Digital Competence for Lifelong 
Learning - Institute for Prospective Technological Studies - IPTC, Main Mas-
sage
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Digitalna pismenost 12

Digitalna pismenost obsega možnost dostopanja do digitalnih 
medijev in IKT, jih razumeti in kritično ovrednotiti z različnih 
vidikov digitalnih medijskih vsebin in medijev ter z njimi učin-
kovito komunicirati v različnih kontekstih. Po Allanu Martinu 
in Janu Grudzieckem3 ločimo tri ravni digitalne pismenosti.

                          

Digitalne zmožnosti (kompetence), ki predstavljajo vstopno ra-
ven, so opredeljene tudi v priporočilu Evropske skupnosti kot 
ključne kompetence (ES, 2006). Vključujejo varno in kritično 
uporabo IKT za zaposlovanje, izobraževanje, osebni-razvoj in 
sodelovanje v družbi. Ta široka opredelitev digitalnih zmožno-
sti določa okvir pristojnosti (tj. znanje, spretnosti in odnose) za 
delo, bivanje in učenje v družbi znanja.4

Pri opisu temeljnih zmožnosti gre seveda za več kot zgolj po-
znavanje recimo MS Worda ali Excela, v katerem učitelj napiše 
pripravo, letni delovni načrt ali izpolni mesečno realizacijo. 
Opisano spada med »gospodinjska opravila« vsakega pedagoga, 
saj se z uspešnim vodenjem administracije pedagoški proces še 
ni začel. Od glasbenika se pogosto pričakuje veliko; od znatnih 
kognitivnih sposobnosti, gibalnih tehnik in fizičnih spretnosti, 
pa do izstopajoče čustvene inteligence. Glasba je namreč široko 
polje obravnavanja zvoka, slike in giba. Najnovejša tehnologija 
kar sama nagovarja k vsakodnevni rabi dandanes nujne e-po-
šte in brskanja po svetovnem spletu. V profesionalnem smislu 
pa pomeni poznavanje in obvladovanje interaktivnih vsebin na 
spletu, delo v spletni učilnici in zopet sem pri tabli − interak-
tivno tablo, uporabo e-gradiv, pa da ne pozabim ''tihe agresije'' 
facebooka in twitterja. Slednje postane obvladljivo, ko se šolski 
kabinet s pomočjo IKT preseli v domačo kuhinjo in poleg mu-
zanja domače mačke nežno prede ventilator prenosnika. 

1  
2  

3  DigEuLit: Concepts and Tools for Digital Literacy Development, 1. 6. 2011
4  ipts.jrc.ec.europa.eu, European Commission, Digital Competence for Lifelong 

Learning - Institute for Prospective Technological Studies - IPTC, Policy Brief, 1. 
6. 2011

Ko podrobno pogledamo izobraževalni proces, kaj hitro ugoto-
vimo, da je digitalna kompetenca sestavljena iz več kompetenc 
in predstavlja nosilni element 2. in 3. ravni digitalne pismeno-
sti. Zajema namreč temeljna znanja, ki si jih je nekdo pridobil 
npr. pri urejevalniku besedil (MS Word), pa jih s pomočjo in-
tuitivnosti uporabe programa Sibelius lahko uporabi v tekstov-
nem urejevalniku, npr. za vnos besedila v Sibeliusu. Tako lahko 
konkretno govorimo o digitalni uporabi, npr. vnos libreta, ki 
smo ga prekopirali nekje s spleta na želeno skladbo, ki smo jo 
že napisali v Sibeliusu. 

Kako program Sibelius podpira 
digitalne zmožnosti?

Na prvi ravni, ko torej opisujemo zmožnosti, lahko s pomočjo 
nekega osnovnega znanja računalništva dokaj spretno popri-
memo za enostavnejša opravila v Sibeliusu. Enostavno je vna-
šanje notnih vrednosti s pomočjo grafičnih vmesnikov, kot so 
orodna okna za numerične tipkovnice in za tonske višine s po-
močjo virtualne klaviature ali tipk na tipkovnici. 

Tabela delitve temeljnih kompetenc5

1. Poznavanje in zmožnost kritiËne uporabe IKT

Glede na usmeritev Evropske komisije o preferenčni uporabi 
odprtokodnih in brezplačnih programov, je zagotovo za glas-
benega pedagoga izjemno uporabno poznavanje dostopnih 
programov za izdelavo elektronskih učnih gradiv za pouk nau-
ka o glasbi (HotPot in Audacity), brezplačnih glasbenih dato-

5 Martin, A. in Grudziecki, J. (2006): DigEuLit: Concepts and Tools for Digital 
Literacy Development. Dostopno na: http://www.ics.heacademy.ac.uk/italics/
vol5iss4/martin-grudziecki.pdf, 1. 6. 2011

3. raven: digitalna preobrazba 

(inovacije, ustvarjalnost)

2. raven: digitalna uporaba 

(uporaba na poklicnem podroËju, 

prenos na strokovna podroËja)

1. raven: digitalne zmožnosti / e-kompetence 

(znanje, spretnosti, drža, pristopi …)
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Tabela delitve digitalne pismenosti na tri ravni

PomoË programa Sibelius pri digitalnem opismenjevanju
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tek (midi) in notnih knjižnic (IMSLP). Gre torej za temeljna 
znanja in spretnosti, ki smo si jih pridobili nekje drugje, pa jih 
s pomočjo različnih pristopov lahko uporabimo pri osnovnem 
notografiranju. Program Sibelius se je poleg osnovne funkcije 
notografiranja v nadgradnjah razvil v kompleksen sklop različ-
nih modulov, ki učinkovito podpirajo vse ravni digitalne glas-
bene pismenosti.

Učinkovito prestavitev pouka v virtualno učilnico omogoča 
Moodle6, ki je postal že standard za delo v spletnem učnem 
okolju. Ogledate si ga lahko na Slovenskem izobraževalnem 
omrežju7. 

6  Moodle (angl. kratica za Modular Object-Oriented Dynamic Learning Envi-
ronment) je prosto dostopno odprtokodno spletno učno okolje (angl. CMS 
- Course Management Systems), ki podpira e- izobraževanje in omogoča up-
ravljanje s tečaji, predmeti, anketami itd.

7 http://skupnost.sio.si/, 1. 6. 2011

2. Zmožnost komunikacije in sodelovanja na daljavo 

Spletna učilnica moodle je lahko več kot uspešen komunikator 
med učenci, starši, učitelji, vzgojitelji in drugimi strokovnimi 
delavci v VIZ. Sibeliusov zapis datotek je seveda bogatejši kot 
so običajne MIDI datoteke. Predvajanje napisane glasbe omo-
goča učencu vizualno in aurealno8 sledenje. Pri vizualnem po-
gledu na notno gradivo namreč učenec zelo dolgo izvaja bolj 
ali manj uspešno prevajanje v grafičnem smislu. Tonski priklic 
(ang. Aureal recall) glasbeniku ali učencu glasbe sproža pri-
merjavo, ki je vezana na njegov posluh in mu je bolj domača. 
Pri takšnem načinu predstavitve tako prihaja do t.i. dvokanal-

nega pomnjenja, saj se grafično prevajanje podpre s tonsko pri-
merjavo. 

Razvijalci programske opreme pri Sibeliusu so poskrbeli, da je 
v mrežni različici dodan modul za nadzor učilnice (Classroom 
control). Prednost tega pred različnimi programi za nadzor na-
mizij je v dejstvu, da se pri vklopu nadzora učilnice ne zapušča 
programsko okolje Sibeliusa. Učitelj lahko preko preprostega 
grafičnega vmesnika pošilja učencem naloge, vmes pregleduje 
napredovanje opravila, piše učencem komentarje in opozorila, 

8 Aurelano ali slušno okolje je zvočni prostor, ki poslušalcu omogoča slušni 
priklic (angl. Aureal recall) npr. posameznega glasbenega motiva in ima 
ključno vlogo pri izgradnji posluha.

Nadzor uËilnice

Spoznati osnove notografije 

v programu Sibelius 6.

opravilo

vnos

Tonske višine

RitmiËne vrednosti

DinamiËne oznake

Libreto

tipkovnica in miška

orodna vrstica

klaviatura

uvoz iz MIDI datotek

Primer razdelitve najosnovnejših opravil s pomoËjo enostavnih 

vnosnih orodij.

Primer, kako lahko v moodlu uspešno postavimo Sibeliusove 

datoteke, lahko pa tudi vgradimo njegov bralnik Scorch. 
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zaciji, kar pa se kaj hitro spremeni, ko želimo prepisati sklad-
bo nekega skladatelja. Pred samim zapisovanjem se moramo 
prepričati, da je skladba v javni domeni, torej da predstavlja 
nekakšno javno dobro. Zavedati se moramo namreč, da avtor-
sko pravo ugasne šele 50 let po skladateljevi smrti, v nekaterih 
državah pa celo po 70 letih. V Sloveniji ureja avtorske pravice 
Zakon o avtorski in sorodnih pravicah (ZASP). Ta zakon ure-
ja: pravico avtorjev na njihovih delih s področja književnosti, 
znanosti in umetnosti (avtorska pravica); pravice izvajalcev, 
proizvajalcev fonogramov, filmskih producentov, radijskih ali 
televizijskih (RTV) organizacij, založnikov in izdelovalcev po-
datkovnih baz (sorodne pravice); individualno in kolektivno 
upravljanje in uveljavljanje avtorske in sorodnih pravic. 

Zelo pogosto smo tudi precej naivni pri varni rabi interneta. Ko 
namreč neka informacija ali izdelek »uide« na svetovni splet, 

tam za vedno tudi ostane. V učnem procesu se zato vse bolj 
uporabljajo zaprti sistemi, ki zahtevajo avtentikacijo9. Zato je še 
posebej uporaben moodle, ki natančno opredeljuje vloge posa-
meznih udeležencev in s tem tudi njihove uporabniške pravice. 
Sibeliusov modul nadzor učilnice deluje samo znotraj mreže 
po sistemu intraneta. Če je torej računalniška mreža ustrezno 
zaščitena, praktično ni možnosti, da bi izdelki učencev brez ve-
dnosti učitelja zapustili varno okolje učiteljevega nadzora. 

Posebno mesto pa zahteva obravnava piratstva. Mnogi zmo-
gljivi programi, v katere je bilo vloženega veliko znanja in ra-
zvojnega kapitala, so plačljivi. V to skupino spada tudi Sibelius. 
V zadnji različici so razvijalci temeljito poostrili varnost in li-
cenciranje izdelkov. Pa vendar so akademskim verzijam dopu-
stili možnost, da je licenca enega programa lahko naložena na 
dveh računalnikih, ki pa ne more biti hkrati delujoča na obeh. 
Tako se učitelj odjavi s službenega računalnika v kabinetu in se 
z isto licenco prijavi na prenosniku. Ne smemo pozabiti, da ima 
razvoj tudi svojo ceno.

9 Avtentikacija je postopek potrditve verodostojnosti, ki se običajno izvede 
zaradi varnostnih zahtev na določeni spletni strani.

jim zamrzne pogled in v vsakem trenutku pridobi na svoj ra-
čunalnik trenutni izdelek učenca. S pomočjo pregledovalnika 
verzij pa celo opravi primerjavo med svojo predlogo in učen-
čevim izdelkom, kar je še posebej uporabno, saj nalog ni treba 
tiskati in jih shranjevati v .pdf formate. Preprosto se shranijo v 
skupni mapi, ki je lahko tudi poročilo o napreku učenca. 

3. Zmožnost iskanja, zbiranja, obdelovanja, 
vrednotenja (kritiËne presoje) podatkov, 
informacij in konceptov 

Pomembna prednost zapisovanja v notnih formatih, kot je Si-
beliusov, je v možnosti, da se vselej lahko dodajajo popravki, 
redakcije in nenehne izboljšave, ki so posledica izdelave pri-
merov dobre prakse. Izdelana elektronska učna gradiva v Si-

beliusu lahko učitelj ustrezno ovrednoti in umesti v svoje letne 
delovne načrte nauka o glasbi in individualne mesečne učne 
načrte pri pouku instrumentov. Pomembna novost v Sibeliusu 
je izdelava v modulu verzij, kjer lahko učitelj fazno predstavi 
nek postopek. 

Učitelji lahko že izdelana elektronska gradiva poiščejo, predsta-
vijo in jih samostojno pregledujejo, si jih izmenjujejo s kolegi in 
jih primerno vrednotijo glede na učni proces.

4. Varna raba in upoštevanje pravnih in etiËnih 
naËel uporabe ter objave informacij 

Dosledno upoštevanje pravnih in etičnih načel uporabe in ob-
jave e-gradiv po standardih netetike se najpogosteje pojmuje 
z uveljavljanjem avtorskega prava in etičnimi načeli uporabe 
skladb v javni domeni. Dokler predstavljamo določena teore-
tična izhodišča, npr. lestvice, akorde in kadence, se zagotovo ne 
bo nihče obregnil v naš zapis. Prepisovanje ljudskih pesmic in 
napevov prav tako ne sme sprožiti nikogaršnje želje po avtori-

Primer predavanja s predstavitvijo obratov D5, kjer grafiËno 

predstavitev s pomoËjo predvajalnika tudi zvoËno predvajamo.

PomoË programa Sibelius pri digitalnem opismenjevanju
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6. Zmožnost naËrtovanja, izvedbe, evalvacije 
pouka (uËenja in pouËevanja) z uporabo IKT

Program Sibelius omogoča tudi zelo enostavne postopke za 
izdelavo transpozicij, menjav ključa, dodajanja klavirskih spre-
mljav in celo možnost samodejnega aranžiranja s pomočjo 
modula Aranžer. Gradivo, zapisano v Sibeliusovem formatu, 
lahko učitelji transponirajo, aranžirajo, transkribirajo in ko-
repetirajo le z nekaj kliki miške in z intuitivno rabo bližnjic. 
Posebej uspešno se izkaže tudi medpredmetno povezovanje 
med instrumentalnim poukom in NGL. Enostavna uporaba 
vtičnikov znatno pospeši postopke vnosa in zmanjša možnost 
zapisovanja napak. V prejšnji številki sem podrobneje predsta-
vil možnosti uporabe vtičnikov OCR in OMR za zajem notne-
ga in zvočnega gradiva in vtičnikov za izdelavo, preoblikovanje 
ter preverjanje gradiva v Sibeliusu 6. 

Posebej zanimiva je izvedba pouka s pomočjo i-table. Sibelius 
vsebuje različne grafične vmesnike za vnos, nadzor in izvedbo 
posameznega dejanja. Kot predavatelj na tečajih sem opazil 
veliko navdušenje učiteljev pri projekciji Sibeliusa na i-tablo. 
Posebej so bili presenečeni nad preprostostjo opravil s pomo-
čjo elektronskega pisala, ki učinkovito nadomešča miškin ka-
zalec in zmožnostjo takojšnjega zvočnega predvajanja. Prava 
popestritev pa je vedno sledila, ko sem poleg najobičajnejših 
orodnih oken, kot so numerična tipkovnica, navigator in 
predvajalnik, pokazal še mešalnik zvoka, klaviaturo, kitarsko 
ubiralko in video urejevalnik. Slednji je pravcat dragulj pro-
grama, saj s pomočjo klaviature in dobršne mere kreativnosti 
prikličemo čas nemega filma in poustvarimo zvočno kuliso, 
bodisi z izseki znane glasbe ali pa napišemo popolnoma svojo 
avtorsko z dodajanjem različnih glasbenih efektov. Pomislite, 
kakšno uvodno motivacijo bi lahko pomenila kratka, morda 
enominutna video predstavitev s podpisano glasbo, ki bi ji sle-
dilo recimo predavanje o kadencah in modulacijah.

Uresničevanje učnih ciljev je z uporabo Sibeliusovih gradiv 
zaradi možnosti sistematičnega načrtovanja učnih ur in učnih 
sklopov mnogo enostavnejše. Kritično vrednotenje same iz-
vedbe pouka z uporabo Sibeliusa pa pogosto narekuje zanimi-
ve primere dobre prakse, ki si jih učitelji lahko z uporabo IKT 
enostavno izmenjujejo. 

Ko pride gora k Mohamedu ali zakaj glasbenik 
potrebuje raËunalnik

Se še spomnite tiste sivozelene ‚‘električne‘‘ zvočne table, ko je 
učenec v eno roko prijel ožičen kontakt, s prstom druge roke 
pa vlekel ali poskakoval med prostori okrušenih in mnogokrat 
premalo obrisanih prostorov notnega črtovja? Zvočni genera-
tor je ustvarjal presunljiv ton, ki me danes spominja, dovolite 

5. Izdelava, ustvarjanje, posodabljanje, objava 
izdelkov (gradiv)

Ko sem primerjal različne programe za notografijo, sem bil vse-
lej navdušen nad pedagoškim občutkom razvijalcev Sibeliusa. 
Poleg spletne strani, ki je že nekaj let nazaj vsebovala kratke in-
struktivne filme za posamezna opravila, me je posebej pritegnil 
njihov koncept izobraževanja s pomočjo kratkih delavnic, ime-
novan Sibelius Project. Imenovana zmožnost izdelave, ustvar-
janja, posodabljanja in objavljanja gradiv me je vedno znova 
prepričala, saj je vsebovala vse ključne parametre e-učenja.

Zagotovo se večina pedagogov najprej sooči s temeljno dilemo, 
koliko časa bodo potrebovali za izdelavo nekega izdelka. Izde-
lava lastnega gradiva za pouk je morda res od začetka zamud-
nejša, vendar pa program vsebuje veliko gradnikov za poeno-
stavitev postopkov izdelave. Pri času pa se običajno prihrani 
kasneje, saj je iz obstoječega e-gradiva mogoče ustvariti različ-

ne izpeljave, v razmeroma zelo kratkem času. Da je program 
Sibelius resnično pisan na kožo glasbenim pedagogom, zopet 
potrjuje izjemno uporaben modul Ustvarjalec delovnih listov. 
Gre za zanimiv pristop organiziranja in sistematizacije učnega 
gradiva, napisanega v Sibeliusu. Učitelj si v preprostem vmesni-
ku Ustvarjalca zlahka ustvari lastno bazo gradiv po kategorijah 
in lastne delovne liste za instrumentalni pouk in NGL. Poso-
dobitve in priredbe obstoječih gradiv so sistematično opisane 
in ustrezno ovrednotene v pogovornem vmesniku Izdelovalca 
delovnih listov, kar lahko bistveno poenostavi uporabo učnih 
listov pri že izvedenem pouku. 

V zadnji različici so šli snovalci še korak dlje in uporabnikom 
ponudili tudi možnost izdelave delovnih listov, ki vsebujejo 
bodisi fiksna, bodisi naključna vprašanja. Z nekaj kliki lahko 
učitelj izdela vsakemu učencu svojo nalogo, ne glede na veli-
kost razreda. 

Ustvarjalec delovnih listov
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ry name:, v katerega vpišite 07 NGL (prvih šest kategorij je 
že privzeto postavljenih).

2. Kliknite na novo kategorijo 07 NGL in dodajte podkate-
gorijo s klikom na gumb Add. Ko se prikaže pogovorno 
okno New category name:, vanj vpišite 01 Predavanje. Z 
gumbom Back se vrnite v glavno kategorijo 07 NGL.

3. Kliknite na kategorijo 07 NGL (če že ni izbrana) in dodajte 
podkategorijo s klikom na gumb Add. Ko se prikaže pogo-
vorno okno New category name:, vanj vpišite 02 Vaje. Z 
gumbom Back se vrnite v glavno kategorijo 07 NGL. 

4. V kategoriji 07 NGL dodajte še podkategoriji 03 Preizkusi 
in 04 Diktati. Z gumbom Back se vrnite v glavno kategori-
jo 07 NGL. 

2. Ustvarjanje delovnega lista iz niË

1. Izberite File> New ali kliknite gumb orodne vrstice. Pojavi 
se nov zapis. 

2. Za papir izberite Blank manuscript paper in kliknite 
Change Instruments. V pogovornem oknu, ki se pojavi, 
potrdite skupne instrumente Common Instruments iz-
brane s seznama Choose.

3. S seznama razpoložljivih instrumentov izberite Others fa-
mily in Unnamed (treble staff). 

4. Kliknite Add to Score in nato potrdite z OK. Zaključite s 
Finish, da zaprete pogovorno okno in ustvarite nov zapis. 

3. Prilagajanje delovnega lista

1. Odprite nov zapis z gumbom Finish.
2. Dodajte še nekaj taktov in ustvarite začetno postavitev strani: 

Izberite Create > Bar > Other. V pogovornem oknu, ki se 
pojavi, določite število taktov na 27 in kliknite OK. Kliknite 
kjerkoli v zapisu, da bi dodati nove takte. Kliknite Esc. 

3. Izberite samodejne prelome taktov Layout > Auto Breaks. 

da uporabim kulinarično metaforo, na pregrešno zapeljiv ham-
burger. Naj mi oprostijo vse multinacionalne prehrambene ve-
rige, ko si pogosto skušam po prijetni paši za oči na reklami v 
naglici potešiti kruleče drobovje, ki se mi najraje oglasi med 
drugim stavkom koncerta ali med čutno kantileno, posebej če 
se izvaja v presunljivem pianissimu. Ko se z mislimi vrnem v 
svet zvokov, se iz otroštva spominjam tudi fascinantnega zvoka 
različnih električnih orgel in prototipov prihajajoče tehnologije 
sintetizatorjev zvoka. Efekt deja vu je oplazi tudi tiste spomine 
z začetka osemdesetih, ko je sosedov Joško že imel pogrošno 
mamljiv Commodore in vse tiste fine igrice, s Tertisom na čelu, 
jaz pa sem neuspešno žical starega za ‚‘Atarija‘‘. Pa vendar je vsa 
tehnologija izpred tridesetih postala neštetokrat reciklirana 
plastika, ki je narekovala, da lahko danes preverimo mulca po 
mobiju, ki smo mu ga kupili v akciji za nekaj evrov. Dragi bral-
ci, poizkusite najstniku, ki vsak večer piše disertacijo na face-
booku, pojasniti, kako se je vse skupaj začelo. Sam sem doživel 
medgeneracijski kratek stik, po katerem so mi še nekajkrat po-
čile varovalke. Generacija, ki jo poučujemo, se je z računalni-
ško tehnologijo že rodila, njihova časovna premica se prične z 
Windowsi, saj njihovo časovno stikalo deluje kot malček, ko si 
pokrije oči in se zadere »Ni me!« Kje smo pa mi?

Delavnica

Delavnica obravnava izdelavo baze učnih listov po kategorijah 
za pouk nauka o glasbi, izdelavo lastnih učnih listov in mo-
žnosti uporabe različnih tipov učnih listov. Ogledali si boste 
postopke za izdelavo učnega lista za učenca in lista z odgovori. 
Predstavljena pa bo tudi novost v Sibeliusu 6, izdelava in pre-
verjanje znanja z naključnimi vprašanji.

1. Urejanje ustvarjalca delovnih listov

1. V menijski vrstici kliknite File in odprite menu Edit 
Worksheets … V pogovornem oknu Edit Worksheets kli-
knite gumb Add. Prikaže se pogovorno okno New catego-
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2. Izberite Create > Text > Subtitle. Kliknite na vrhu prve 
strani in vtipkajte 1. Delovni list.

3. Izberite House Style > Edit All Fonts. Spremenite pisave 
Main Text Font v Verdana z izborom iz spustnega seznama. 

4. Kliknite na naslov, da ga izberete. Izberite House Style> Edit 
Text Styles. Na seznamu razpoložljivih slogov besedila bi 
bilo treba izbrati naslov; kliknite Edit. Na strani horizontal-
na lega izberite, Left under Align to page in kliknite OK. 

5. Izberite podnaslov s seznama razpoložljivih stilov besedila 
in kliknite Edit. Na strani General page preklopite na ležeče/ 
Italic. Na strani horizontalna lega izberite Left under Align 
to page in kliknite OK. Kliknite Close, da se vrnete na zapis.

5. Vstavljanje lestvic s pomoËjo vtiËnika

1. Izberite Plug-ins > Other > Scales and Arpeggios. V po-
govornem oknu, ki se pojavi, se prepričajte, da izberete Add 
scales and arpeggios to current score in kliknite Next.

2. Izberite durove lestvice/ Major Scales s spustnega seznama 
in kliknite Next.

3. Prepričajte se, da je Scale Type nastavljen na Major in da je 
možnost Include key signature vklopljena.

4. Izberite All except octave na spustnem seznamu Number 
of scales or arpeggios in Interval of start notes na Diato-
nic na spustnem seznamu. Tako se bodo vstavile vse durove 
lestvice, ki se začenjajo od C pa vse do C. Kliknite Finish. 

5. Označite zadnjo lestvico C major in jo izbrišite. Kliknite na 
posamezne okvirje imen lestvic in jih poslovenite, npr. C 
major v C-dur. B major morate posloveniti v H-dur.

6. Dodajanje v predloge delovnih listov

1. Izberite File > Add to Worksheet Creator.

V pogovornem oknu, ki se pojavi, preklopite na Use auto 
system breaks in izberite Every 4 bars. Kliknite OK. 

4. Prilagodite nastavitev številčenja taktov in pokritosti strani s 
takti v iste vrste v zapisu. House Style > Engraving Rules.   

 Na strani za številčenje taktov Bar Numbers, nastavite fre-
kvenco na No bar numbers. Na strani za črtovje v pogo-
vornem oknu Staves>Justification nastavite Justify staves 
when page is at least n% full na 100%. Zaprite pogovorno 
okno pravil. 

5. Izberite Layout> Document Setup. Spremenite primerno 
vrednost velikosti črtovja na 6 mm. Kliknite OK, da se vr-
nete na zapis. 

4. Dodajanje besedila, urejanje pisav in sloga besedila

1. Izberite Create > Text > Title. Kliknite na vrh prve strani 
in vtipkajte Lestvice in arpeggi. Kliknite dvakrat Esc, da 
zaustavite urejanje besedila in prekličite vnos. 
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6. Vnesite v polje Cirriculum level NGL 5 in odstranite klju-
kico v potrditvenem polju Answer sheet. Dvokliknite na 
kategorijo 07 NGL in podkategorijo 01 Predavanje potrdi-
te z OK.

8. Delovni list za uËenca in odgovori

1. V odprtem dokumentu spremenite navodilo v Napiši dia-
tonične dvooktavne lestvice v osminkah. Prvo lestvico C-
dur pustite za primer nedotaknjeno. Drugo lestvico, D-dur 
in ostale pa označite ter vse njihove tone iz 1. glasu spre-
menite v 3. glas. Kliknite 3. glas na numerični tipkovnici, 
obarva se rumeno.

2. Ponovno označite izbor od D-dura do H-dura in vse pa-
vze v 1. glasu s kombinacijo tipk Ctrl+Shift+Alt+1 in jih 
skrijte s kombinacijo tipk Ctrl+Shift+H. Datoteko shranite 
na namizje z imenom Diatonične dvooktavne lestvice od 
C do H dura. 

3. Izberite File > Add to Worksheet Creator. Izberite Tea-
ching and learning materials izmed Type options. Vnesi-
te v polje Cirriculum level NGL 5 in potrdite kljukico za 1. 
glas v potrditvenem polju Voices shown on student sheet. 
V potrditvenih poljih Voices shown on answer sheet pa 
morajo biti potrjene vse kljukice, za vse štiri glasove.

4. Dvokliknite na kategorijo 07 NGL in podkategorijo 02 Vaje 
potrdite z OK.

5. Odprite ustvarjalca delovnih listov Worksheet Creator in 
označite potrditveno polje Teaching and learning materi-
als. Potrdite kljukici na potrditvenih poljih Add to Workshe-
et >On Student Sheet>Today’s date in Spaces for student 
name and class, poljih On Answer Sheet pa obkljukajte 
Today’s date in Cirriculum level ter kliknite Next. 

6. V pogovornem oknu Choose kliknite Next, v oknu Choo-
se from s seznama izberite 07 NGL>02 Vaje>Diatonične 
lestvice.

2. Izberite Template izmed Type options in poimenujte vaš 
delovni list, npr. Diatonične lestvice. 

3. Izpolnite polje za opis za učitelje Description (for teacher). 
Diatonične dvooktavne durove lestvice v osminkah od 
C-dura do H-dura.

7. Dodajanje v uËni in vadbeni material

1. Odprite ustvarjalca delovnih listov Worksheet Creator in 
označite potrditveno polje Template.

2. Odstranite kljukici na potrditvenih poljih Add to Wor-
ksheet >On Student Sheet>Today’s date in Spaces for 
student name and class ter kliknite Next. 

3. Na seznamu predlog označite predlogo z imenom Diato-
nične lestvice in potrdite s Finish. 

4. Iz plavajočega menija Create>Text>Other Staff Text izbe-
rite plavajoče besedilo Plain text za navodilo. S kurzorjem 
se prestavite pod podnaslov in vpišite v navodilo Diatonič-
ne dvooktavne lestvice v osminkah. 

5. Izberite File > Add to Worksheet Creator. Izberite Tea-
ching and learning materials izmed Type options. 
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9. V Meniju File>datoteka vklopite dodajanje dokumenta v 
Ustvarjalca delovnih listov>Add to Worksheet Creator. 

10. V vnosnem polju za ime dodajte Diatonične lestvice na-
ključno v spodnjem vnosnem oknu Instructions (for stu-
dent) pa vpišite Napiši diatonične dvooktavne lestvice v 
osminkah in izberite opcijo vsebine za naključna vprašanja 
Options>Contains: Random questions. Spremenite vre-
dnost v Bars per question na 4 in Question per system na 
Default. Učni list shranite v kategorijo 07 NGL>02 Vaje in 
kliknite OK.

11. Poiščite učni list v Ustvarjalcu 07 NGL>02 Vaje>Diatonične 
lestvice naključno in v pogovornem oknu nastavite vre-
dnost Number of questions na 3 in po predogledu odprite 
dokument. 

12. Zapomnite si vrstni red lestvic (D-E-F) ob naslednjem od-
piranju bo morda (E-G-H).

 

Pouk nauka o glasbi je za marsikaterega učenca precej zoprn. 
Govorim iz lastnih izkušenj z učenci. Razkorak med motivaci-
jo za pouk instrumenta in NGL pa je na žalost vse večji. Zato 
menim, da lahko vključevanje e-gradiv, tudi s pomočjo Sibeliu-
sa, znatno zmanjša ali pa celo odpravi vrzel med predmetoma. 
Tokratno delavnico sem zato posvetil vsem tistim pedagogom 
in učencem nauka o glasbi, ki medsebojno trpijo, v želji, da bi 
se njihovi pogledi s pomočjo uporabe IKT vsaj malo zbližali. 

9. Delovni list za uËenca z nakljuËnimi vprašanji

1. Odprite ustvarjalca delovnih listov Worksheet Creator in 
označite potrditveno polje Teaching and learning materi-
als.

2. Odstranite vse kljukice na potrditvenih poljih Add to Wor-
ksheet in kliknite Next. 

3. V naslednjem pogovornem oknu Choose naj bo privzeto 
Type of material označeno Size of Group: Any in prav 
tako How to use: Any. 

4. V spustnem seznamu pogovornega okna Choose from 
izberite 07 NGL>02 Vaje>Diatonične lestvice in kliknite 
Next.

5. Predogled zaključite z gumbom Finish.
6. Na učnem listu za učitelja Answer Sheet izbrišite dodano 

ime Answer Sheet levo zgoraj, navodilo Napiši diatonične 
dvooktavne lestvice v osminkah in ime datoteke Filena-
me desno spodaj.

7. Označite z dvoklikom prvo lestvico C-dur in jo prestavi-
te v 3. glas z ALT+3 (kot ostale). Nato označite vse pavze 
v 1. glasu CTRL+ALT+SHIFT+1 in jih skrijte CTRL+ 
SHIFT+H . Označite vsa imena lestvic v pravokotnikih in 
jih prestavite z bližnjico ALT+1 v 1. glas. Vse dvojne črte na 
koncu sistemov spremenite v končaje. 

8. Pripravljen dokument shranite na namizje po imenom Di-
atonične lestvice naključno.


